
35

C
ad

er
no

s U
ni

FO
A

E
di

çã
o 

E
sp

ec
ia

l d
o 

C
ur

so
 d

e 
M

es
tr

ad
o 

Pr
ofi

ss
io

na
l e

m
 M

at
er

ia
is

 - 
Ju

nh
o/

20
13

Implementação passo a passo dos critérios de falhas em flexão em compósitos 
PPS/Fibras de Carbono através do Programa ANSYS

Implementation of the Criteria for failure in bending PPS Composites/Carbon 
Fiber by ANSYS Program

Eder José Siqueira1

Roberto de Oliveira Magnago1,3

Fernando de Azevedo Silva2

Edson Botelho Cochieri2

Palavra-chave:

Compósitos,

Critérios de Falhas,

Modelamento pelo 
ANSYS.

Abstract:
The constant development of materials together with the need to achieve 
high performance structural components such as alternative materials 
in the aerospace industry as well as considering the applicability of 
current composite structural predictions of failure of the structure and 
analysis of the maximum loads that can withstand the same become 
fundamental research topics in order to guarantee reliability in the 
use of these in various areas. Whereas the thermoplastic composite 
type PPS/C - Poly (phenylene sulfide) reinforced with carbon fibers is 
emerging as an alternative to thermoset polymer composites and there 
are still shortages in the current literature data on the prediction of 
failure, this study holds in two-dimensional analysis of the mechanical 
behavior of the composite PPS/C under static load linear three-
point bending and traction. Were analyzed through this study, the 
failure criteria of maximum tension, polynomial criteria indices of 
strength and inverse relationships of power indices Tsai-Wu, Hill and 
Hoffman. Finally, we compared the results obtained from the computer 
model with experimental results, in order to analyze, evaluate and 
validate the numerical simulation as a complement of laboratory tests.  

Keywords:

Composites,

Failure Criteria,

Modeling by ANSYS. 

Resumo:
O constante desenvolvimento dos materiais aliado à necessidade de se 
obter componentes estruturais de alto desempenho como materiais al-
ternativos na indústria aeronáutica, bem como considerando a aplicabi-
lidade atual dos compósitos estruturais, previsões de falha da estrutura 
e análise das cargas máximas que as mesmas podem suportar se tornam 
tópicos	fundamentais	de	pesquisas	com	a	finalidade	de	garantia	da	con-
fiabilidade	quanto	ao	emprego	dos	mesmos	em	diversas	áreas.	Consi-
derando que o compósito termoplástico do tipo PPS/C - Poli (sulfeto 
de	fenileno)	reforçado	com	fibras	de	carbono	está	surgindo	como	uma	
alternativa a compósitos poliméricos termorrígidos e que ainda há escas-
sez na literatura atual de dados relativos à previsão de falhas, este tra-
balho se detém na analise bidimensional do comportamento mecânico 
do	compósito	PPS/C	sob	carregamento	estático	linear	em	flexão	de	três	
pontos e em tração. Foram analisados através deste trabalho os critérios 
de falha de máxima tensão, critérios polinomiais dos índices de força 
e das relações inversas dos índices de força de Tsai-Wu, de Hill e de 
Hoffman.	Por	fim,	foram	comparados	os	resultados	obtidos	através	do	
modelo computacional com os resultados experimentais, com o objetivo 
de analisar, avaliar e validar a simulação numérica como complementa-
ção dos ensaios experimentais.

1 UniFOA – Centro Universitário de Volta Redonda
2 Faculdade de Engenharia de Guaratinguetá - Unesp - Universidade Estadual Paulista
3UERJ - Universidade do Estado do Rio de Janeiro
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1. Introdução

Com o desenvolvimento da indústria 
aeroespacial surgiram os compósitos de plás-
tico	reforçados	com	fibras	de	alta	resistência.	
Devido a esse impulso, a variedade de mate-
riais atualmente disponíveis para utilização 
em engenharia é extraordinariamente grande, 
atendendo	 aplicações	 específicas.	 Inseridos	
nesse contexto, os materiais compósitos avan-
çados representam um caso de particular rele-
vância dentro dos materiais de engenharia não 
convencionais, especialmente para aplicações 
estruturais aeronáuticas. 

Este trabalho se detém a avaliar e validar 
alguns critérios de falhas contidos no aplica-
tivo computacional ANSYS e implementar 
através das tensões obtidas pela simulação nu-
mérica mais dois critérios de falhas que são 
os critérios de Hill e de Hoffman para efeito 
comparativo. 

2. Critérios de falhas em materiais 
compósitos ortotrópi-cos

Dentre os critérios de previsão inicial de 
falhas analisados neste trabalho, destacam-se:
•	 Critério fenomenológico da Máxima 

Tensão;
•	 Critério polinomial de Hill;
•	 Critério polinomial dos índices de forças 

de Tsai-Wu;
•	 Critério polinomial das relações inversas 

dos índices de forças de Tsai-Wu;
•	 Critério polinomial de Hoffman.

3. Materiais e Métodos

Neste trabalho foi estudado um com-
pósito estrutural polimérico com matriz ter-
moplástica PPS - Poli(Sulfeto de Fenileno) 
reforçado	 com	 tecidos	 de	 fibras	 de	 carbono	
(configuração	5HS	–	“satin weave”), forneci-
do pela empresa holandesa Ten Cate Advanced 
Composites.	O	conteúdo	volumétrico	de	fibras	
foi de 60% avaliado pelo método de digestão 
ácida, (DE FARIA, 2008). Os laminados es-
tudados	apresentam	configuração	[0º/90º]3s, e 
conseqüentemente, apresentam uma espessura 
nominal de 1,86 mm. As amostras deste lami-
nado foram devidamente analisadas por en-

saios de ultra-som e microscopia óptica, com 
a	principal	finalidade	de	garantir	a	qualidade	
das mesmas na realização dos ensaios expe-
rimentais.
 
4. Ensaios Mecânicos

Para o desenvolvimento deste trabalho, en-
saios	de	tração,	cisalhamento	Iosipescu	e	flexão	
em três pontos foram realizados com base nas nor-
mas ASTM-D3039/D3039 M-00, ASTM-D5379 
e DIN-EN-2562, respectivamente. 

5. Implementação dos modelos 
numéricos em elementos finitos 
com ANSYS

A simulação numérica foi pré-proces-
sada, processada e pós-processada pelo apli-
cativo computacional ANSYS, sendo que os 
dados experimentais foram tomados como 
referência para avaliar as tensões de resistên-
cia	do	material	PPS/C	em	flexão	e	 tração	na	
simulação numérica, com o principal objetivo 
de validar a sua utilização na análise de falha 
de materiais compósitos.

O procedimento passo a passo para re-
alização	da	simulação	numérica	em	flexão	de	
três pontos é destacado a seguir:

Primeiramente	define-se	o	título	da	aná-
lise com os seguintes passos: 

Utility Menu → File → Change Title 
→	Ok, conforme apresentado na Figura 1.

Figura 1 – Barra do menu utilidades.

Após esta etapa inicia-se a construção 
geométrica	 do	 laminado,	 definindo	 inicial-
mente os pontos chaves: 

Preprocessor → Modeling → Create 
→ Keypoints → In Active CS →	Ok, con-
forme apresentado na Figura 2.

Figura 2 – Criação dos pontos chaves que delimitam 
geometricamente o laminado.
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Criando os pontos chaves que delimi-
tam geometricamente o laminado, o aplicativo 
computacional gera os pontos de contorno do 
laminado, conforme demonstrado através na 
Figura 3.

Figura 3 – Criação dos pontos chaves que delimitam a geometria 
do laminado compósito em estudo.

Logo após esta etapa, criam-se as linhas 
entre	os	pontos	chaves	com	a	finalidade	de	de-
limitar geometricamente o corpo em análise, 
seguindo os seguintes passos: Preprocessor 
→ Modeling → Create → Lines → Lines → 
Strainght Line →	Ok, conforme representa-
do na Figura 4.

Figura 4 – Criação das linhas interligando os pontos chaves.

Geometricamente o laminado se apresenta, 
conforme representado na Figura 5 a seguir.

Figura 5 – Criação de linhas de ligação entre os pontos chaves 
para delimitação geométrica do laminado compósito.

Define-se	 a	 seguir	 as	 áreas	 entre	 as	 li-
nhas, considerando que o estudo foi realizado 
no estado plano de tensão (EPT) basta criar 
geometricamente um elemento de área para 
realizar o estudo, ou seja: Preprocessor → 
Create → Áreas → Arbitrary → By Lines 
→	Ok, conforme apresentado pela Figura 6.

Figura 6 – Criação das áreas para formação do laminado plano.

Passando o laminado a obter a forma 
plana, conforme apresentado na Figura 7.

Figura 7 – Criação das áreas do laminado compósito.

Após a criação das áreas faz-se neces-
sário efetuar a colagem das mesmas, utilizan-
do o comando: Preprocessor → Operate → 
Booleans → Glue → Áreas → Ok, conforme 
representado pela Figura 8.

Figura 8 – Colagem das áreas.

Define-se	 a	 seguir,	 o	 tipo	 de	 elemento	
adequado ao estudo, que no caso deste traba-
lho, o elemento adotado foi o elemento Shell99 
por ser um elemento ortotrópico e linear em 
função da análise proposta. O processo para 
a escolha do elemento foi: Preprocessor → 
Element Types → Add/Edit/Delete → Add 
→ Library of Element Types → Shell → 
Linear-Layer 99 → Ok, conforme represen-
tado pela Figura 9.

Figura	9	-	Definição	do	tipo	de	elemento.

Define-se	a	partir	daí	alguns	detalhes	do	
elemento adotado, que no caso deste trabalho 
foi indicado, por exemplo: o número máxi-
mo de lâminas contidas no laminado (seis 
lâminas), a alteração da constante K5 que 
define	as	tensões	e	deformações	no	laminado	
e a alteração da constante K8 que indicava 
aonde o carregamento será efetuado no 
laminado, ou seja: Preprocessor → Element 
Type → Options → Shell99 element type 
options → Ok → Close, conforme apresen-
tado na Figura 10.
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Figura 10 – Dados opcionais do elemento em estudo.

Após a escolha do tipo de elemento, se 
insere	as	constantes	reais	que	definem:	a	sime-
tria	do	laminado,	as	disposições	das	fibras	no	
laminado em termos de ângulos e a espessura 
de cada lâmina, sendo que o processo segue 
os seguintes passos: Preprocessor → Real 
Constants → Add/Edit/Delete → Add → 
Element Type for Real Constants → Ok; 
Real Constants Set Number 1 for Shell99 
→ Ok → Close, conforme apresentado nas 
Figuras 11 a 14.

Figura	11	–	Definição	das	constantes	reais.

Figura	12	–	Definição	da	constante	real	para	o	material	em	
análise.

Figura 13 – Indicação da quantidade de lâminas e simetrias do 
laminado.

Figura	14	–	Definição	do	material,	ângulo	das	fibras	e	espessura	
das lâminas.

A	seguir	define-se	o	tipo	de	material	se-
guindo os passos: Preprocessor → Material 
Props → Material Models, sendo que neste 
processo o ANSYS automaticamente solici-
ta a introdução das constantes de engenha-
ria Ex , Ey , vxy , e Gxy relativas ao material em 
estudo	 e	 a	 partir	 daí	 define-se	 a	 análise	 do	
estudo,	 que	 para	 este	 trabalho	 foi	 definida	
como: Preprocessor → Material Props → 

Material Models → Structural → Linear 
→ Elastic → Ortotropic → Close, conforme 
representado pelas Figuras 15 e 16.

Figura	15	–	Definição	do	tipo	de	material	para	análise.

Figura 16 – Introdução das constantes de engenharia do material.

A seguir são introduzidas as tensões de 
resistência do material para as análises dos cri-
térios de falhas Xt , Xe , Yt , Ye e S , para o EPT, 
seguindo os seguintes passos: Preprocessor 
→ Material Props → Failure Criteria → 
Add/Edit → Ok, conforme representadas pe-
las Figuras 17 e 18.

Figura 17 – Escolha do material a ser adicionado o critério de falha.

Figura 18 – Introdução com as tensões de resistência à tração, 
compressão e ao cisalhamento do compósito.

Define-se	 a	 seguir	 a	malha	 do	 elemen-
to,	 sendo	que	para	este	 trabalho,	 foi	definida	
manualmente e adotado uma malha quadrada 
de 1 mm de dimensões. Para tanto foi segui-
do os passos: Preprocessor → Meshing → 
Size Controls → Manual Size → Áreas → 
All Áreas → Ok, conforme apresentado na 
Figura 19. 

Figura 19 – Indicação das dimensões do elemento a ser 
discretizado.
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E Preprocessor → Meshing → Mesh 
→ Áreas Free → Pick all, conforme apresen-
tado na Figura 20.

 Figura 20 – Indicação das áreas a serem discretizadas.

Para	o	 ensaio	de	flexão	 em	 três	pontos	
o	 laminado	 ficou	 discretizado	 conforme	 de-
monstrado na Figura 21.

Figura	21	–	Discretização	do	laminado	em	flexão	de	três	pontos.

Partindo para a fase de solução do pro-
blema em estudo, o tipo de análise do problema 
é	definido,	que	para	este	trabalho	foi	adotada	
uma análise estática. Os passos são: Processor 
→ Analysis Type → New Analysis → Static 
→ Ok, conforme representado na Figura 22.

Figura	22	–	Definição	do	tipo	de	análise	para	carregamento.

Nesta	 etapa	 se	define	 a	 restrição	do	mo-
vimento e o tipo de carregamento, sendo que 
para a restrição do movimento foi restringido o 
movimento de deslocamento do laminado nos 
apoios em direção ao eixo Y, seguindo o pas-
so: Processor → Define Loads → Apply → 
Structural → Displecement → On lines → 
Ok, conforme apresentado na Figura 23 e 24.

Figura 23 – Comando para restringir o movimento.

Figura 24 – Caixa comando para indicação da restrição do 
movimento.

Para a inclusão do valor do carrega-
mento no centro do laminado, a força média 
de ruptura obtida na fase dos ensaios expe-
rimentais foi transformada em uma tensão e 
aplicada conforme ensaio realizado, em uma 
área de 10 mm2 do centro do laminado e para 
tanto foi adotado o seguinte passo na simula-
ção: Processor → Define Loads → Apply → 
Structural → Pressure → On Áreas → Ok, 
conforme apresentado nas Figuras 25 e 26.

Figura 25 – Comando para aplicar tensão (pressão).

Figura 26 – Implementação do carregamento (tensão) no 
laminado.

Após esta etapa o aplicativo computa-
cional	 gera	 a	 figura	 com	 restrição	 no	movi-
mento e indicação do carregamento, conforme 
demonstrado pela Figura 27.

 Figura 27 – Restrição do movimento e carregamento do 
laminado.
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Após a inclusão da tensão, deve ser re-
querido ao aplicativo computacional a apre-
sentação da solução do problema, seguindo 
o passo: Processor → Solution → Solver → 
Current LS → Ok → Close, conforme repre-
sentado na Figura 28.

Figura 28 – Solver do aplicativo computacional ANSYS.

A partir desta etapa passamos ao Pós-
processador, onde as soluções do problema 
são plotadas, sendo que para obter tais recursos 
devem-se seguir os seguintes passos: General 
Postproc → Plot results → Contour Plot → 
Nodal Solution, conforme representado na 
Figura 29. Através deste comando pode-se op-
tar	pela	representação	gráfica	das	tensões,	de-
formações, deslocamentos e critérios de falhas 
em relação aos nós do elemento.

Figura	29	–	Comando	relativo	as	obtenção	gráfica	das	soluções	nodais.

Pelo comando General Postproc → 
List Results → Nodal Solution, conforme 
apresentado na Figura 30, pode-se obter a lis-
tagem dos dados que representam os valores 
calculados relativos às reações do laminado 
em relação ao carregamento informado. Esta 
listagem representa as tensões nodais, defor-
mações nodais, deslocamentos nodais e índi-
ces de falhas, sendo que no caso do aplicativo 
ANSYS para este trabalho foi analisado os cri-
térios de falhas de máxima tensão, índices de 
forças de Tsai-Wu e das relações inversas dos 
índices de força de Tsai-Wu.

Figura 30 – Comando para obter a listagem de valores relativos à 
solução do problema.

6. Conclusões 

Concluiu-se com este trabalho que o 
emprego da simulação numérica no ANSYS é 
válido, pois apresentou resultados numéricos 
aproximados dos resultados experimentais, e 
considerando também que com tais análises 
o projetista pode com garantia e segurança 
avaliar as respostas dos materiais compósitos 
estruturais sob carregamento estático linear 
no que diz respeito à previsão inicial de falha, 
dentro de uma análise que envolve os princi-
pais critérios de previsão inicial de falha, que 
são os critérios de máxima tensão, de índices 
de forças de Tsai-Wu e das relações inversas 
dos índices de forças de Tsai-Wu, critérios 
estes amplamente indicados pelas literatu-
ras	afins.	O	emprego	da	 simulação	numérica	
além de proporcionar a garantia e segurança 
dos resultados, possibilita a realização de uma 
análise ágil e menos dispendiosa, sem a neces-
sidade de envolvimento de mão de obra qua-
lificada	para	preparo	e	execução	das	amostras	
e da análise experimental, como também sem 
a necessidade da aquisição de material para 
este	fim,	 de	 posse	 somente	 das	 propriedades	
elásticas do compósito e suas resistências à 
ruptura fornecidas pela literatura. A simulação 
numérica, pode ser empregada para efeito de 
redução de custo e otimização no projeto de 
determinada estrutura.
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